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Team Time 

Data Storage Options 

Students should be assessed on the following:  

1. Research conducted on data storage option 

2. Recommendations match the needs and goals of company and staff 

Needs 
improvement  

Done  
Adequately 

Done  
Well 

Research on data 
storage options 

Students have 
identified the needs 
and goals of 
company and staff 

Students have 
outlined the benefits 
and disadvantages of 
various options, 
identified a solution 
or combination of 
solutions, and 
provided support for 
the recommendation  

Ethics Project 

Green Computing

1. Students need to create and summarize a situation that involves green computing. 
The event/scenario should involve more than one character so that role-playing 
can take place.  

2. Students need to create an outline to use during a role-playing event.  
3. Students role-play the event using chat or other collaborative tools.  
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4. Students should present their case/experience to the class via PowerPoint or other 
method as determined by instructor.  

Needs 
improvement  

Done  
Adequately 

Done  
Well 

Students need to 
create and 
summarize a 
situation that 
involves green 
computing.  

Students need to 
create an outline to 
use during a role-
playing event.  

Students role-play 
the event using chat 
or other collaborative 
tools.  

Students should 
present their 
case/experience to 
the class via 
PowerPoint or other 
method as 
determined by 
instructor. 



Technology in Action, 14th Edition 
Chapter 2 

making the transition to…next semester 

1. Watching Device Demos 

YouTube is a great resource for product demonstrations. Open your browser, navigate to 
YouTube (youtube.com), and search on any type of computer peripheral discussed in this 
chapter to see if you can find a demonstration of a cool product. How helpful are these 
demonstrations? Make a video demonstration of a computing device you have and post it 
to your course management system or present it to your classmates (as specified by your 
instructor). 

The videos on YouTube have made it a go-to site for students looking to learn more. If 
you ask students to evaluate a demonstration they watch on YouTube, they might respond 
by describing how helpful the video was, whether more than one brand was 
demonstrated, how old the video was, whether troubleshooting tips were included, and 
whether anything was left out that the students believed was important.  

If you ask students to create a demonstration video, a word of caution is in order. If there 
is a desire to maintain privacy, allow students to create a video but don’t penalize them 
for not uploading it to YouTube. For the content, think about what you would want to 
share with another future user about a device that you use regularly. What do you use it 
for and how has it benefited you? What do you wish was in the manual but wasn’t there? 
Also, make sure that there is some uniformity and quality to creating the video, perhaps 
with everyone using the same type of recording device such as a digital recorder or a 
digital camera with video capability, and a tripod.  

2. Communicating with the Computer 

You’re involved in many group projects at school. Between your work, your classes, and 
other outside responsibilities, you’re finding it difficult to meet in person. Investigate the 
devices you would need to be able to have virtual group meetings. 

To get students started, have them research the options for a new user of VoIP. In their 
analysis, consider these questions: What devices are needed? Do they need to purchase 
new equipment or do they have the capacity in their computer already? Does it require a 
lot of training to use or is it simple? Can free software be used? Will there be any 
monthly expense? How will this choice compare to other communication options?  

Students can also perform an Internet search for “free video conferencing” and find 
several sites where their meetings can be hosted at no cost. Facebook offers networking 
options and Skype is another alternative. In addition, wiki sites and software such as 



Google Docs give multiple users the capability to provide input on a single document. 
Devices needed include a camera and microphone.  

3. Ultrabook or Tablet 

You need a new computing device for school. Consider the following: 

a. Explain the differences between a tablet and an ultrabook. 

b. What advantages would an ultrabook provide you for your academic career? 

c. What advantages would a tablet (such as an iPad) provide to you in the classroom? At 
home? 

d. Which device do you think is better suited to your needs? Explain fully. 

This is a great project for students, as they are often considering the purchase of new 
computing devices. Start the students off by getting them to focus on identifying their 
particular needs, since this is what should drive the choice of device. Perhaps in class, 
have students make a list of their needs and then complete the product research as 
homework. Typical factors students consider are: product weight, battery life, 
connectivity options, compatibility with existing systems/devices, screen size, storage 
capacity (although less so with cloud storage solutions becoming popular). Students often 
cite the need to record lectures with these devices.

making the transition to…the workplace 

1. Backing Up Your Work 

You’ve embarked on a position as a freelance editor. You’ll be using your own computer. 
Until now, you haven’t worried too much about backing up your data. Now, however, it’s 
extremely important that you back up all your work frequently. Research the various 
backup options available, including online backup services, external hard drives, and 
portable flash storage. What are the size limitations of each? What are the initial and 
ongoing costs of each? How frequently do the options allow you to perform backups? 
Which option would you would choose, and why? 

Losing data creates a horrible situation. Yet many users take for granted that technology 
will always do what we need it to do when we need it to work. What types of precautions 
would students take to ensure their personal files are protected and what would they do 
to keep their work files protected? Students’ answers may vary, but should include a 
discussion about the various storage options available, including portable options such 
as flash storage, external storage devices, and online or cloud-based services. Students 
should discuss the pros and cons of each method, including cost and storage space 
limitations. Is this something students can do without an expert or will additional tech 
support fees be incurred? What are the best case scenarios for retrieving lost data and 
how often should data be backed up?  



2. What Hardware Will You Use? 

When you arrive at a new position for a company, your employer will most likely provide 
you with a computer. Based on the career you’re in now or are planning to pursue, 
answer the following questions: 

a. What kind of computer system would the company mostly likely provide to you—
desktop, laptop, tablet PC, or something else? How does that compare with the type of 
system with which you prefer to work? 

b. If you were required to use a type of computer you’d never used before (such as a Mac 
instead of a PC), how would you go about learning to use the new computer? 

c. What other devices might your employer provide? Consider such items as smartphones 
or peripherals such as printers. How important is it for these devices to conform to the 
latest trends? 

d. Should you be able to use employer-provided equipment, such as a smartphone, for 
personal benefit? Does your answer differ if you have to pay for part or all of the device? 

Responses will vary, depending on career choice and individual preferences. What do 
individuals in this career typically use? For example, a graphic designer might own a 
laptop but use a large monitor or multiple monitors with a desktop computer. If you are 
moving into sales, you might use a tablet or an ultrabook. What is your preference?  

It can be is difficult to begin using a program or operating system that is different from 
what you are accustomed to using. Yet, it is easier to learn to use a computer now than it 
used to be, and likewise it should be even easier in the future. Think about sources for 
tutorials for the various operating systems. Are there videos on YouTube or from the 
manufacturer that you can use to learn? How do you best learn: watching and then 
doing, reading and then doing, or trying first instead?  

Employees should not take advantage of the employer. What guidelines would be 
reasonable for personal use of equipment provided by the employer? 



[[Begin Solve This]] 

Solve This 

[[Insert MyITLab®grader icon]] 

Technology Wish List 

You are in need of a significant technology upgrade, and your parents have told you they 

will help you finance your purchases by loaning you the money. You will need to repay 

them with a modest 2.5% interest rate over two years. The only catch is that they want 

you to create a list of all the new devices that you need, note the cost, and provide a 

website for each device where they can find more information. Then, they want you to 

calculate how much you will need to give them each month to pay them back. 

You will use the following skills as you complete this activity:

• Merge and Center • Modify Column Widths 

• Modify Workbook Themes • Insert a Hyperlink 

• Apply Number Formats • Create a Formula 

• Use the SUM, PMT, and COUNTA Functions • Wrap Text 

Instructions: 

1. Open TIA_Ch2_Start and save as TIA_Ch2_LastFirst.  

2. Format the title in cell A1 with the Title Cell Style, and format the column headers 

in cells A3:F3 with the Heading 3 Cell Style. 

a. Hint: To format cell styles, on the Home tab, in the Styles group, click Cell 

Styles. 

 3. Merge and Center A1 across columns A through F, and Center align the column 



headers in cells A3:F3. 

a. Hint: To Merge and Center text, on the Home tab, in the Alignment group, click 

Merge & Center. 

 4. Modify column widths so that Column A is 25 and Column D is 45. 

a. Hint: To modify column widths, on the Home tab, in the Cells group, click 

Format, and then select Column Width. 

 5. In cells B4:F9, fill in the table with the Brand and Model of the six devices that you 

would like to purchase. The device type is filled out for you. In the Reason column, 

write a brief note as to why this device will help you. (You’ll format the text so it all 

displays later.) Enter the cost of the device in the Cost column. Don’t include tax 

and/or shipping. 

 6. Change the Workbook Theme to Integral.

a. Hint: To apply the Theme, on the Page Layout tab, in the Themes group, click 

Themes. 

 7. In cells F4:F9 create a Hyperlink to a webpage that features each respective product 

so your grandparents can have access to more information if they need it. Ensure that 

each hyperlink includes the URL to the exact webpage for the device in the Address, 

but displays the Make/Model of the device in the worksheet.  

a. Hint: To insert a hyperlink, on the Insert tab, in the Links group, click Hyperlink. 

In the Insert Hyperlink dialog box, enter the URL in the Address: box and enter 

the Make/Model in the Text to display box.  

 8. Wrap the text in cells C4:C9, D4:D9, and F4:F9 so all text displays. 

a. Hint: To wrap text, on the Home tab, in the Alignment group, click Wrap Text. 



 9. Format the values in cells E4:E9 with the Accounting Number format with two 

decimals. 

a. Hint: To apply number and decimal formats, look on the Home tab, in the 

Number group. 

10. In cell A10, type Subtotal, then in cell E10 use a SUM function to calculate the total 

cost of all devices. Format the results in the Accounting Number format with two 

decimals. 

11. In cell A11, type Estimated Tax, then in cell E11 create a formula that references the 

subtotal in cell E10 and multiplies it by a tax of 6%. Format the results in the 

Accounting Number format with two decimals. 

a. Hint: The formula will be =E10*0.06 

12. In cell A12, type Estimated Shipping, then in cell E12 create a formula to calculate 

the shipping charge by using the COUNTA function to determine the number of 

devices being purchased and then multiplying that by a $10 shipping charge. Format 

the results in Accounting Number Format with two decimals. 

a. Hint: The formula will be =COUNTA(B4:B9)*10. 

13. In cell A13, type Total Cost, then in cell E13 use the SUM function to create a 

formula that adds up the Subtotal, Estimated Tax, and Estimated Shipping costs. 

Format the results in Accounting Number Format with two decimals. Format the 

cells A13:E13 with the Total Cell Style. 

14. Right align cells A10:A13. 

15. In cell D14, type Estimated Monthly Payment, and then in cell E14, use the PMT 

function to calculate the monthly payment owed to your parents to pay back the total 



purchase amount in two years at a 2.5% annual interest rate. 

 Hint: The formula will need to adjust the annual interest rate to a monthly rate, and 

adjust the annual term of the loan to monthly payments. 

16. Save the workbook and submit based on your instructor’s directions. 



Chapter 2 Quiz // Assessment 

multiple choice 

<OBJECTIVE 2.1> 
1. Which of the following functions of a computer is mostly responsible for turning data into 

information? 
a. processing 
b. storage 
c. input 
d. output 

<OBJECTIVE 2.2> 
2. In a computer, each_____ can represent one letter, number, or symbol. 

a. bit 
b. byte 
c. integrated circuit 
d. megabyte 

<OBJECTIVE 2.3> 
3. A(n) ______ is a laptop computer that can convert into a tablet-like device. 

a. ultrabook 
b. Chromebook 
c. 2-in-1 PC 
d. all-in-one PC 

<OBJECTIVE 2.4> 
4. Touch-screen devices usually feature _____________ keyboards. 

a. physical 
b. laser-projection 
c. optical 
d. virtual 

<OBJECTIVE 2.6> 
5. All of the following are sensors found in certain smartphones EXCEPT 

a. hygrometer. 
b. accelerometer. 
c. magnetometer. 
d. barometer. 

<OBJECTIVE 2.14> 
6. Ergonomics is an important consideration 

a. only for desktop computers. 
b. only for laptop computers. 



c. only for laptop and desktop computers, but never for mobile devices. 
d. for all computing devices. 

<OBJECTIVE 2.7> 
7. The most common output device for soft output is a 

a. laser printer. 
b. display screen. 
c. inkjet printer. 
d. scanner. 

<OBJECTIVE 2.8> 
8. ________ printers work by spraying tiny drops of ink onto paper. 

a. Laser 
b. Cloud-ready 
c. Inkjet 
d. Large format 

<OBJECTIVE 2.12> 
9. The fastest computer port is the ______ port 

a. USB 
b. Thunderbolt 
c. expansion 
d. WiFi 

<OBJECTIVE 2.13> 
10. Which component of a computing device drains the battery the fastest? 

a. display screen 
b. hard drive 
c. WiFi adapter 
d. Bluetooth adapter 

true/false 
1. Data and information are interchangeable terms.  <False (OBJ 2.1)>
2. RAM is nonvolatile storage. <False (OBJ 2.9)>
3. SSD drives are superior to conventional disk drives because they have no moving parts.

<True (OBJ 2.11)>
4. A touch pad is a pointing device usually found in tablets. <False (OBJ 2.5)>
5. The “brain” of the computer is the CPU. <True (OBJ 2.10)>



Check Your Understanding // Review & Practice 2.1 

multiple choice 
<OBJECTIVE 2.1> 
1. Which of the following is one of the four major functions of a computer? 

a. indexing 
b. verification 
c. processing 
d. handling 

<OBJECTIVE 2.3> 
2. Which of the following statements is TRUE? 

a. All cell phones are now smartphones. 
b. Smartphones are considered a type of computer. 
c. Smartphones do not contain a CPU. 
d. Smartphones have more computing power than desktop computers. 

<OBJECTIVE 2.4> 
3. Which of the following can be both an input device and an output device? 

a. mouse 
b. keyboard 
c. display screen 
d. laser printer 

<OBJECTIVE 2.7> 
4. The number of pixels that can be displayed on the screen at one time is known as what? 

a. screen resolution 
b. viewing angle 
c. color depth 
d. pixel density 

<OBJECTIVE 2.8> 
5. What type of printer heats toner to adhere it to the paper? 

a. inkjet 
b. impact 
c. 3D 
d. laser 



Check Your Understanding// Review & Practice 2.2

multiple choice 
<OBJECTIVE 2.9> 
1. Which of the following is NOT found on a motherboard? 

a. RAM 
b. CPU 
c. sound card 
d. hard drive 

<OBJECTIVE 2.10> 
2. Which of these is considered the “brains” of the computer? 

a. USB 
b. ROM 
c. RAM 
d. CPU 

<OBJECTIVE 2.11> 
3. Which of these is an example of optical storage media? 

a. DVD 
b. SSD 
c. thumb drive 
d. a flash memory card 

<OBJECTIVE 2.12> 
4. Which of the following is NOT a port? 

a. HDMI 
b. CPU 
c. USB 
d. Thunderbolt 

<OBJECTIVE 2.13> 
5. Which power control option performs a warm boot? 

a. Restart 
b. Sleep 
c. Log off 
d. Shut down 



Chapter 2 Make: A Mobile App 

Getting to Know App Inventor  
App Inventor is a web-based tool for creating mobile apps for Android devices. In this exercise, 

you’ll explore the App Inventor tool and begin working with your first app. 

 

When using App Inventor (on a PC) to build an app, it is very helpful to have an Android device 

connected to the same wireless network as the PC. This allows you to see changes to your app 

live on the Android device as shown in the videos below: 

Before You Start 

For this exercise, you’ll need the following: 

HARDWARE 

1. A computer connected to a WiFi network 

2. An Android device (phone or tablet) that is connected to the same WiFi network as the 

computer. (Note: If you don’t have an Android device, you can instead work with the 

emulator in App Inventor. A “phone” will appear on the screen and show what your app 

will look like running on a phone screen. For information on setting up the emulator, 

follow these instructions: http://appinventor.mit.edu/explore/ai2/setup) 

SOFTWARE 

3. The Chrome browser (free and available at https://www.google.com/intl/en-

US/chrome/browser/) 

4. A Google account (free and available at 

https://accounts.google.com/signup?service=mail). A Google account will work for all 

Google services like Gmail, Maps, and Google Play. 

5. The MIT AI2 Companion app (free and available at Google Play). Make sure to 

download the latest version onto your Android device. 

  

http://appinventor.mit.edu/explore/ai2/setup
https://www.google.com/intl/en-US/chrome/browser/
https://www.google.com/intl/en-US/chrome/browser/
https://accounts.google.com/signup?service=mail


Working with Your First App  

It’s a tradition in programming to make the first program you write in a new language print 

“Hello, World” on the screen. For App Inventor, the first program everyone sees is Hello Purr. In 

this exercise, you will set up your app inventor account and explore the Hello Purr app. 

 

1. Navigate to http://ai2.appinventor.mit.edu. If you’ve never logged into App Inventor 

before, you’ll be asked to sign in with your Google Account: 

 

  

Enter your Google account name 

Enter your Google account password 

http://ai2.appinventor.mit.edu/


2. Enter your Google account name and password, and allow App Inventor access to your 

Google account. You’ll only be asked to do this the first time you access your account. 

You will be asked to agree to the Terms of Service (you must accept the terms of service 

to use App Inventor) and you may be asked to take a voluntary survey. 

 

3. Click the Continue button to dismiss the Welcome to App Inventor dialog box. Your 

screen should now look like this: 

 

4. At the top of the screen, click Projects to display the Projects drop-down menu. From the 

Projects menu, select Import Project (.aia) from a repository. This will display the 

Built-in Templates screen. 

Click to dismiss dialog box 



 

  

Select to import a project 

from a repository 

Select to display the 

Projects menu 



5. Select the HelloPurr template from the list in the Built-in Templates group (Note: At 

the time this document was constructed, only two templates were available. You may see 

additional templates listed.) 

6. Click OK to load the HelloPurr template into AI2. 

 

Click the app name to 

select it 

Click OK  



The Designer interface has several key sections, as shown above: 

 Palette: This section contains the components you’ll use to build apps. 

 Viewer: This section shows the components that have been added to the app. 

 Components: This section lists all screens in the app, plus the components on each 

screen. Selecting a screen or component displays the properties for that element in the 

Properties section. 

 Properties: This section lists all properties of the element currently selected in the 

Components section. 

 

  



7. Next you need to connect App Inventor and your Android device. Turn on your Android 

device and launch the AI Companion app.  You should see a screen on your Android 

device that looks like this: 

 

  



8. On your computer, in App Inventor, click the Connect drop-down arrow from the menu 

at the top of the screen, then click AI Companion from the drop-down menu. This 

launches the Connect to Companion dialog box. (Note: If you don’t have an Android 

device, click Emulator from the drop-down menu.) 

 

  

Connect menu option 

Click AI Companion to 

connect to your Android 

device 



9. Click the button scan QR code on your device and hold it so the QR code on your 

computer screen is in focus. Wait for the two to synchronize. (Note: You can also just 

type the six-character code into the Six Character Code box in the Companion app on 

your Android device, and then press the orange connect with code button.) 

 

 

  

Six-character code 

QR code 



If you successfully connected, the Connect to Companion dialog box should disappear, and the 

screen on your Android device (or the emulator screen) should now display the HelloPurr app, as 

shown below:  

10. Now take some time to play with your device and see what the app does. Does it make noise? 

Does your device vibrate (Note: the emulator will not vibrate and neither will some tablets.)? 

 

 

 

  



Behind the App 

Now that you have loaded the HelloPurr app and played with it, let’s examine how the HelloPurr 

app was designed. We will now explore the AI2 interface to familiarize you with its different 

components. 

User Interface 
1. Navigate to the Components window. There you see the HelloPurr app uses one screen. That 

screen has: 

 Button1 

 Sound1 

 

2. Navigate to the Media window, which shows that there are two files uploaded: 

 the image kitty.png 

 the sound meow.mp3 

 

  



3. In the Components window, click Button1 to select it. The Properties window shows all the 

details of that Button. Notice the Button has an image tied to it, kitty.png.  

 

  

Image tied to 

button 



4. In the Components window, click Sound1 to select it. The Properties window shows it has a 

Source file associated with it, meow.mp3.  

 

Note: As you make changes to the app in the AI2 user interface on your computer, the app will 

update automatically on your Android device (or in the emulator). 

  

Sound file 

associated with 

Sound1 



Behavior (Blocks Screen) 
Now let’s examine how the HelloPurr app is programmed. We will explore the Blocks view to 

see what is happening. 

1. In the upper-right corner of the AI2 screen, click the Blocks button. This switches you to the 

Blocks view, which enables you to control the behavior of the app. Blocks are representations of 

programming code built into App Inventor. They make it possible for you to assign actions to 

components of your app without knowing the details of a complex programming language. 

 

  

Blocks button 

Block that controls 

behavior of the 

HelloPurr app 



2. In the Blocks palette, click the Button1 object. This opens the “drawer” of blocks that control 

the button’s behavior. 

 

The when blocks are gold in color and are tied to actions the user may take. Note: There are 

other types of blocks, but we won’t deal with them until future exercises. 

The HelloPurr app uses the event block “when Button1.Click” (as shown below). This block 

controls what happens when a user presses Button1 (the picture of the cat) when the app is 

running. When Button1 is clicked, the Sound1 object is told to play the source file associated 

with it and the device will vibrate for 500 milliseconds (like a cat purring). 

 

  

Button1 

object 

When blocks 



This is the basic pattern for all mobile apps you’ll create with App Inventor: 

 Design the user interface 

 Decide which actions are important (pressing a button, select an item from a list, etc.) 

 Program the behavior with blocks 

A Mystery App 

We have created a mystery app for you to explore. (Note: This app requires actions that are not 

supported in the emulator). 

1. Download the file Chapter2MakeThis.aia from MyITLab and save it to your computer. 

2. On the App Inventor menu, click Connect->Reset Connection. 

3. Click Projects->Import project (.aia) from my computer and click the Choose File 

button. Navigate to the folder where you saved the Chapter2MakeThis.aia file and select 

it. 

4. Click the OK button to load the app into App Inventor. Your screen should look like this: 

 

5. Launch the AI companion app on your Android device. 



6. On the App Inventor menu, click Connect->AI Companion and connect to your 

Android device. Enter the code either by typing or by scanning the QR code. You device 

should look like this: 

 

7. Now play with your device. Move it around. Shake it. What is changing? When are things 

changing? What kind of blocks might be behind this? 

8. When you have an idea of what is happening, open the Blocks view and examine the 

code. Were you correct? 

9.  Try making some modifications or adding new behaviors. For example, try going to 

Designer view and adding a Text to Speech component (found in the Palette pane under the 

Media category) and a Text Box (in the User Interface category) and then using those to extend 

what the app can do (make the picture say the phrase typed in the text box by the user when the 

picture is touched). 

Now that you know the basics of the App Inventor programming interface and how to connect an 

Android device to it, you can begin building your own apps! 

  



Extensions to This Project 

1. Take a “selfie” and modify the HelloPurr app to use your picture as the button image 

instead of the cat image. 

2. Record your voice saying something clever. Upload this sound file to the HelloPurr app 

and tie that sound to the button. Your picture will now have your voice! 

3. Add a text to speech component to the HelloPurr app. Enable the user to type in the 

phrase that will be spoken when the picture button is pressed. 

Resources 

 User Guide for App Inventor 2 

 Guide to Understanding Blocks 

 MIT App Inventor Support Forum 

 Beginner Tutorials (with videos) 

 

Note: If you want to build the HelloPurr app from scratch, a tutorial to construct it is located 

at http://appinventor.mit.edu/explore/ai2/hellopurr.html. 

 

MIT App Inventor is a blocks-based programming tool that allows everyone, even novices, 

to start programming and build fully functional apps for Android devices. Google's Mark 

Friedman and MIT Professor Hal Abelson co-led the development of App Inventor while Hal 

was on sabbatical at Google. App Inventor runs as a Web service administered by staff at 

MIT’s Center for Mobile Learning - a collaboration of MIT’s Computer Science and 

Artificial Intelligence Laboratory (CSAIL) and the MIT Media Lab. MIT App Inventor 

supports a worldwide community of nearly 3 million users representing 195 countries 

worldwide. App Inventor is an open-source tool that seeks to make both programming and 

app creation accessible to a wide range of audiences. App Inventor is the property of the 

Massachusetts Institute of Technology (MIT) and the work licensed under a Creative 

Commons Attribution-ShareAlike 3.0 Unported License. For more information on App 

Inventor, go to MIT App Inventor About Us page. 

 

http://appinventor.mit.edu/explore/library.html
http://appinventor.mit.edu/explore/ai2/support/blocks.html
https://groups.google.com/forum/#!forum/mitappinventortest
http://appinventor.mit.edu/explore/beginner-tutorials-short.html
http://appinventor.mit.edu/explore/ai2/hellopurr.html
http://creativecommons.org/licenses/by-sa/3.0/
http://creativecommons.org/licenses/by-sa/3.0/
http://appinventor.mit.edu/explore/about-us.html
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Android: https://www.android.com. A customizable OS that powers a variety of devices from phones 
and tablets to watches, and more.

App Inventor: http://www.appinventor.org/. A site that offers a course taught by USF Professor David 
Wolber through which students of all ages can learn how to invent and program an app within hours. 

Apple: www.apple.com. Information about Apple’s macOS, iOS, iPhone, Watch, iPad, iPod, and iTunes, 
as well as information about Mac computers such as MacBook Air or iMac. 

Apple AirPrint: www.apple.com. Click the Search icon, then search for AirPrint and select from the list 
of articles. 

Apple Siri: www.apple.com. To locate information on Siri, click on the Search icon, type Siri in the 
search text box, and then press Enter. An iOS personal assistant for the iPhone, iPod, and iPad that allows 
users to access the Internet and other features by voice command. 

ASUS ZenBook: www.asus.com/US/. A light, thin, laptop built with a stronger laptop alloy. The 
ZenBook does not have a CD/DVD drive, but does have USB-C 3.1, USB 3.0, HDMI, VGA, RJ45 LAN, 
and 3-in-1 SD card reader ports. 

AT&T: www.att.com. The official site for AT&T, where users can purchase a phone, phone service, and 
other services.

Blackle: www.blackle.com. An energy saving search engine created by Heap Media and powered by 
Google Custom Search. Using a black screen saves energy since backlit LCDs do not light up the area of 
the screen that is black. 

Bluetooth: bluetooth.com. This is the official site for Bluetooth technology. 
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Computer Ethics Institute: computerethicsinstitute.org. This site provides information on ethical issues 
associated with the advancement of information technologies in society. 

Consumer Reports: www.consumerreports.org/cro/index.htm. Expert reviews on thousands of consumer 
products are included here. 

Dragon NaturallySpeaking: http://www.nuance.com/dragon/index.htm?ref=discoverlist. Software by 
Nuance that allows users to dictate content into a computer. 

Dropbox: www.dropbox.com. This free service lets users easily share and bring photos, documents, and 
videos anywhere. 

Epson: www.epson.com. A site that provides access to learn about and purchase Epson products, 
including printers, ink, projectors, scanners, and more. 

Google: www.google.com. A free online search utility. 

Google Cloud Print: https://www.google.com/cloudprint/learn/. New technology that connects printers 
to the web allowing you to print from your phone, tablet, PC, or other web-connected devices.

Google Chromebook: https://www.google.com/chromebook/. A computer that uses Google Chrome OS. 

Google Drive: http://drive.google.com/. A personal drive offered by Google with at least 15 GB of free 
storage space. The drive can be accessed on the web, on a mobile device, or on a computer.

Google Hangouts: https://hangouts.google.com/. An online video app that makes it easy to send 
messages, make voice and video calls, or videoconference with multiple people. This link may have to be 
copied and pasted into the browser address bar. 

Google Maps: www.google.com. Click the Google Apps button in the top right corner, and then click 
Maps. Google Maps uses GPS to allow users to navigate from one location to another or find a specific 
location such as a gas station, restaurant, or store.  

Google Now: https://www.google.com/search/about/. Google’s intelligent personal assistant responds to 
voice commands to perform various tasks.

HP: www.hp.com. The official site for HP products.  

Intel: http://ark.intel.com/. A site that provides information about different computer processors. 

Kodak: www.kodak.com. A site that provides hardware, software, and services to the graphic arts, 
commercial print, publishing, entertainment, and consumer product markets.

Lenovo: www.lenovo.com. A site that provides access to purchase Lenovo laptops, desktops, tablets, and 
accessories. The Lenovo Yoga is a laptop with a hinge that enables users to fold the keyboard behind the 
screen and use the monitor as a tablet. 

LG: http://www.lg.com/us. A site that provides access to purchase LG products. 
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Microsoft Corporation: www.microsoft.com. Information about Microsoft software, hardware, and 
operating systems such as the Office Suite, Microsoft Surface, and Windows 10. 

Microsoft Cortana: http://windows.microsoft.com/en-us/windows-10/getstarted-what-is-cortana. 
Personal assistant software that manages your calendar, tracks packages, finds files, and even chats with 
you.

Microsoft Excel: https://products.office.com/en-us/. Click Products on the red menu bar, and below 
Applications, click Excel. The spreadsheet application Microsoft bundles with Microsoft Office. 

Microsoft OneDrive: www.onedrive.com. Cloud-based file storage and sharing, as well as free access to 
Microsoft Office Web Apps. 

Microsoft Windows 10: https://www.microsoft.com/en-us/windows/features. Learn more about 
Windows 10 and take a video tour of the new Windows features. 

MyFitnessPal: https://www.myfitnesspal.com/. An app that counts calories and captures data using the 
cell phone camera to scan UPC codes on food products. 

Panono: www.panono.com/home. The Panono 360° has 36 fixed-focus cameras that take 36 single 
images. Images are uploaded to the Panono cloud where they are automatically stitched together for a 
360° panoramic image. 

PlayStation: http://us.playstation.com. This site provides information about PlayStation systems and 
games. 

Pokémon Go: http://www.pokemon.com/us/. The official site for the Pokémon Go game. 

R.A.T. Pro X Precision Gaming Mouse: http://www.madcatz.com/. This precision engineered mouse 
provides the ability to customize the mouse and reduces fatigue while playing marathon gaming sessions. 

Rock Band: www.rockband4.com. Click GEAR in the menu bar to learn more about Rock Band 
controllers.  

Samsung: www.samsung.com. This site provides access to purchase Samsung products. 

Skype: www.skype.com. This site provides Voice over Internet Protocol (VoIP) service for users to make 
free phone calls over the Internet. 

Square: https://squareup.com/. A magstripe reader that allows retailers to accept credit cards anywhere 
using Apple and Android devices. 

Sunway TaihuLight: https://www.top500.org/system/178764. This site provides detailed information 
about the world’s fastest supercomputer.

theSkyNet: www.theskynet.org. An organization that uses software to tie individual computing devices 
to a grid to process astronomical data during times when individual CPUs are idle or not working to their 
full capacity. 
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TOP500.org: www.top500.org. A project that started in 1993 to provide a ranking for the top 500 

supercomputers’ abilities to solve a linear set of equations.

U.S. Department of Defense: http://www.defense.gov/. The official government site for the U.S. 
Department of Defense. 

Verizon: www.verizon.com. Verizon offers wireless devices, accessories, and mobile plans, as well as 
residential and business solutions for Internet, TV, and phone services. 

Wake Forest Institute for Regenerative Medicine: http://www.wakehealth.edu/WFIRM. 
A research facility that specializes in engineering laboratory-grown organs and replacement tissues to 
cure rather than treat disease. 

Wii U: http://www.nintendo.com/. A game console by Nintendo. Click Wii U in the menu bar. 

Xbox: www.xbox.com. This is the official Xbox site with information about Xbox systems and games. 

ADDITIONAL LINKS 

4AllMemory: www.4allmemory.com. Find the memory to upgrade your computer. 

AAXA Technologies: http://www.aaxatech.com/. This site offers digital projectors for business and 
education. 

BBC Future: http://www.bbc.com/future/story/20150310-are-you-over-connected. This article discusses 
whether individuals are over-connected to digital media. 

CalRecycle: www.calrecycle.ca.gov/electronics/whatisewaste/. Click Electronic Waste below Where Do 
I Recycle… This site defines e-waste and provides links to more information about electronic waste 
recycling. 

Celluon: http://www.celluon.com/ . A technology company that manufactures a product that projects a 
laser image of a keyboard onto a flat surface and detects the motion of fingers during typing. 

Computer History Museum: www.computerhistory.org. This site presents a history of how computers 
really started and how far they have come since their invention. 

Ergonomics: http://ergonomics.org/. This site provides information on ergonomics and the importance of 
having an ergonomically designed work place. 

Good Clean Tech: www.goodcleantech.pcmag.com. This site provides news, tips, advice, and ideas 
about how to do more with less. With the help of the editors and analysts at PC Magazine, this site 
highlights companies that have committed to using better ecotechnologies. 

Google Documents: docs.google.com. Google’s web-based application suite and data storage service that 
enables users to create documents while collaborating in real-time with other users. 
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Leap Motion: www.leapmotion.com. Leap Motion has developed technology that allows computers to 
be controlled using hand gestures. 

Linux.com: www.linux.com. The latest information on news that affects Linux users. 

Logbar: http://logbar.jp/. Information about the Ring, a wearable input device that can be programmed to 
control iOS and Android compatible devices.

Microsoft Help and Support: support.microsoft.com. Microsoft’s support site includes help topics and 
tutorials for all Microsoft programs. Downloads and updates are also available. 

ooVoo: www.oovoo.com. Web-based video chat and video conferencing software is provided for 
download. 

PCPARTPICKER: https://pcpartpicker.com/. Build guides to create your own computer.

PCWorld: www.pcworld.com. Timely product information for PC, Mac, iPod, and iPhone technologies 
is included on this site. Thousands of products across 33 categories are available for review, comparison, 
and expert purchasing guidance. 

Presto: www.collobos.com. Software that allows users to send images and documents from mobile 
devices to a printer on a home network. 

Projector Central: www.projectorcentral.com. This is a review and information site for projectors. 

Shapeways: www.shapeways.com. Shapeways’ 3-D printing service enables users to design and sell 
custom-printed 3-D objects. 

ThinPrint Cloud Printer: http://cloudprinter.thinprint.com/. An app that allows users to print from all 
their devices to a cloud printer.

Thunderbolt: https://thunderbolttechnology.net/. A site that provides information about Thunderbolt 

technologies in the News and Blog sections. There is also a Developers section for licensed Thunderbolt 

developers.

World Community Grid: www.worldcommunitygrid.org. Software download to make any computer 
part of a scientific research grid that allows the computer to work on research when the CPU is idle. 

Xerox Corporation: http://www.xerox.com/. A site that provides access to learn about and purchase 

Xerox products. 
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WEB RESEARCH PROJECTS 

CHAPTER 2 
LOOKING AT COMPUTERS: 

UNDERSTANDING THE PARTS 

Discussion Questions 

1.  Discuss the four main functions of a computer system and how they interact with data 
and information. 

 Answers will vary. 

A computer is a data processing device that performs four major functions: 
1. Input: It gathers data or allows users to enter data. 
2. Process: It manipulates, calculates, or organizes that data into information. 
3. Output: It displays data and information in a form suitable for the user. 
4. Storage: It saves data and information for later use. 

Computers are excellent at processing (manipulating, calculating, or organizing) data 
into information. 

2. Discuss the guidelines for choosing the best portable device for personal use. 

• Power: How much computational power do you need?  

• Screen size and resolution: Make sure the quality and size of screen will fit your 
needs for the years you’ll keep the device. 

• Style of keyboard: Do you want a touch-based interface? Is a physical keyboard 
important, or is an on-screen keyboard sufficient? Does the feel of the keyboard 
work for you?

• Battery life: Some devices can operate for 15 hours continuously, others less than 
5. Investigate whether the battery can be upgraded and how much weight that 
would add. 

• Weight: Lighter devices usually cost more. Remember to include the weight of any 
charging brick you would need to carry when you travel as you consider the 
tradeoff in price for a lighter device.  

• Number of devices: Is this your only computing device? As technology prices fall, 
you may be able to have more than one device. You might find an affordable 
solution that includes both a very mobile device and a second more powerful one. 
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CHAPTER 2: LOOKING AT COMPUTERS: UNDERSTANDING THE PARTS

Web Project 1: Portable Storage vs. Cloud Storage 

Chapter 2 discusses portable vs. cloud storage. If you had to choose between cloud storage and portable 
storage devices, you would want to research the pros and cons of each to make an informed decision. Write 
a short essay that compares/contrasts portable and cloud storage. Follow your instructor’s directions for 
proper formatting of your research. 

Suggested Websites (Use the Suggested Keywords to Search in Following Links)

www.pcmag.com
www.cnet.com
www.usatoday.com
www.consumerreports.org 
www.carbonite.com

Suggested Keywords 

best way to back up computer, best computer backup options, should I use cloud storage or portable, cloud 
storage options, cloud vs. portable storage 
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CHAPTER 2: LOOKING AT COMPUTERS: UNDERSTANDING THE PARTS

Web Project 2: Buying a Printer 

Imagine you would like to purchase a printer for your personal use at college. Make a chart that compares 
the features (e.g., portability, size, color, and function) of at least six different printers. What is included in 
the package price and what costs extra? In addition to the chart, write a short essay that describes the 
similarities and differences among the different types of printers analyzing your comparison results, and 
finally discuss which model best meets your needs and why. Follow your instructor’s directions for proper 
formatting of your research. 

Suggested Websites (Use the Suggested Keywords to Search in Following Links)

www.pcmag.com
www.computershopper.com
www.top5reviewed.com
www.livewire.com
www.bestbuy.com

Suggested Keywords 

types of printers, best printer options, portable printers, highest rated printers, printer features 
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CHAPTER 2: LOOKING AT COMPUTERS: UNDERSTANDING THE PARTS

Web Project 3: 3-D Printing 

One of the most exciting innovations in printing today is the 3-D printer. These 3-D printers are used in 
marketing, consumer goods, medicine, and so on. Research using the Internet for more information on 
exactly how 3-D printers work and the most recent uses for them. Write a short paper describing how they 
work and their uses. Include some ideas of what you think they might be used for in the future. Follow your 
instructor’s directions for proper formatting of your research. 

Suggested Websites (Use the Suggested Keywords to Search in Following Links)

www.3dprinting.com 
www.goodnet.org 
www.techrepublic.com 
www.pwc.com 
www.explainingthefuture.com 

Suggested Keywords 

3d printing, what are 3d printers used for, innovative uses for 3d printers, future uses 3d printers, why use 
3d printers 
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CHAPTER 2: LOOKING AT COMPUTERS: UNDERSTANDING THE PARTS

Web Project 4: Buying a Portable Computer 

You would like to purchase a portable computer for your personal use. In this chapter, you learned about 
three categories, cell phones, tablets, and laptops. Assuming that you already own a cell phone, write a 
paper that describes the differences among tablets and laptops. Use a search engine to help you make a 
chart that compares the features (e.g., operating system, size, and function) of three tablets and three laptop 
computers. What is included in the package price and what costs extra? Analyze your comparison results 
and inform your instructor which model and type best meets your needs and why. 

Suggested Websites (Use the Suggested Keywords to Search in Following Links)

www.dummies.com
www.consumerreports.org
www.microsoft.com
www.apple.com
www.toshiba.com
www.hp.com

Suggested Keywords 

differences between tablets and laptops, tablet pc, laptop, best tablets, best laptops 
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Understanding Digital Components

• Understanding Your Computer

• Input Devices

• Output Devices
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Understanding Digital Components

Objectives

2.1  Describe the four main functions of a computer 
system and how they interact with data and 
information.

2.2  Define bits and bytes, and describe how they 
are measured, used, and processed.

2.3  List common types of computers, and discuss 
their main features.
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Input Devices

Objectives

2.4  Identify the main types of keyboards and 
touch screens.

2.5  Describe the main types of mice and pointing 
devices.

2.6  Explain how images, sounds, and sensor 
data are input into computing devices.
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Output Devices

Objectives

2.7  Describe options for outputting images and 
audio from computing devices.

2.8  Describe various types of printers, and 
explain when you would use them.
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Understanding Your Computer
Computers are Data Processing Devices (Objective 2.1)

• Perform four major functions

– Input: Gathers data, allows entering data

– Processing: Manipulates, calculates, or organizes 
data

– Output: Displays data and information 

– Storage: Saves data and information
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Understanding Your Computer
Bits and Bytes: The Language of Computers (Objective 2.2)

• Bit

– Binary digit

– 0 or 1

• Byte

– Unique combinations of 8 bits of 0s and 1s

• Kilobytes, megabytes, gigabytes, terabytes, 
and petabytes
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Understanding Your Computer
Types of Computers (Objective 2.3)

• Smartphones

• Tablets

• Laptops and their 
variants

• Choosing a portable 
device

• Stationary 
computers
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Input Devices
Physical Keyboards and Touch Screens (Objective 2.4)

• Used to enter data and instructions 

• Examples

– Keyboard

– Touch screen

– Stylus

– Virtual keyboard
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Input Devices
Mice and Other Pointing Devices (Objective 2.5)

• Mouse

• Touch pad (trackpad)

• Game controllers
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Input Devices
Image, Sound, and Sensor Input (Objective 2.6)

• Popular for images

– Digital cameras

– Camcorders

– Mobil device cameras

– Flatbed scanners

– Webcams

• Popular for sound

– Microphone with voice recognition software

• Sensors
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Output Devices
Image and Audio Output (Objective 2.7)

• Send data out of the computer in the form of:

– Text

– Pictures

– Sounds

– Video

• Examples

– Monitors

– Printers

– Speakers and earphones
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Output Devices
Image Output (Objective 2.7)

• Types of display screens

– Liquid crystal display (LCD)

– Light-emitting diode (LED) 

– Organic light-emitting diode (OLED)

• How they work

– Pixels

– Aspect ratio

– Resolution
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Output Devices
Sound Output (Objective 2.7)

• Speaker

– Output device for sound

– Surround-sound speakers 

– Wireless speaker systems

• Headphones or earbuds

– Keep from distracting others
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Output Devices
Printers (1 of 2) (Objective 2.8)

• Inkjet

– Affordable

– High-quality color 

– Quick and quiet

• Laser

– Faster printing speed

– Higher-quality printouts

– More expensive
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Output Devices
Printers (2 of 2) (Objective 2.8)

• All-in-one printer
– Printer, scanner, copier, and fax

• Large format printer
– Prints oversize images

• 3D printer
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Processing, Storage, and Connectivity

• Processing and Memory on the Motherboard

• Storing Data and Information

• Connecting Peripherals to the Computer

• Power Management and Ergonomics
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Processing and Memory on the 
Motherboard

Objectives

2.9  Describe the functions of the motherboard 
and RAM.

2.10  Explain the main functions of the CPU.
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Storing Data and Information

Objective

2.11  Describe the various means of storing data 
and information with computing devices.
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Connecting Peripherals to the 
Computer

Objective

2.12  Describe common types of ports used 
today.



Copyright © 2018, 2017, 2016 Pearson Education, Inc. All Rights Reserved

Power Management and Ergonomics

Objectives

2.13  Describe how to manage power 
consumption on computing devices.

2.14  Define ergonomics, and discuss the ideal 
physical setup for using computing devices.
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Processing and Memory on the 
Motherboard
The Motherboard and Memory (Objective 2.9)

• Motherboard

– CPU

– ROM, RAM, and cache

– Slots for expansion cards

– Sound/Video cards

– Network interface cards 
(NIC)
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Processing and Memory on the 
Motherboard
Processing (1 of 2) (Objective 2.10)

• Central Processing Unit

– CPU or processor

– “Brains” of the computer

– Controls all functions of the computer’s 
components

– Processes all commands and instructions

– Billions of tasks per second 
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Processing and Memory on the 
Motherboard
Processing (2 of 2) (Objective 2.10)

• CPU Performance Measures

– Processor speed measured in hertz (Hz)

 Megahertz (MHz) or gigahertz (GHz)

– Number of cores

 Single

 Dual

 Quad

 Ten
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Storing Data and Information
Storage Options on Computing Devices (1 of 4) 
(Objective 2.11)

• Local Storage Devices

– Hard disk drive

 Primary storage device

 Nonvolatile storage

 Internal drive

 External hard drive

– Solid-state Drive (SSD)
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Storing Data and Information
Storage Options on Computing Devices (2 of 4) 
(Objective 2.11)

• Portable Storage Options

– Flash drive

– Flash memory card
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Storing Data and Information
Storage Options on Computing Devices (3 of 4) 
(Objective 2.11)

• Cloud storage

– Files stored on the Internet

– Some amount is free

– Can purchase additional storage
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Storing Data and Information
Storage Options on Computing Devices (4 of 4) 
(Objective 2.11)

• Compact discs 
(CDs)

• Digital video discs 
(DVDs)

– Store more data 
than CDs

• Blu-ray discs (BDs)
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Connecting Peripherals to the 
Computer
Computer Ports (Objective 2.12)

• Thunderbolt

– Transfer speeds up to 20 Gbps

• Universal serial bus (USB)

– Transfer speeds of 10 Gbps

• Connectivity port

– Ethernet port

– Up to 10,000 Mbps

• HDMI port



Copyright © 2018, 2017, 2016 Pearson Education, Inc. All Rights Reserved

Power Management and Ergonomics
Power Controls and Power Management 
(Objective 2.13)

• Battery drain

• Power supply

• Sleep mode

• Warm / Cold 
boot

• Hibernate
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Power Management and Ergonomics
Setting It All Up: Ergonomics (Objective 2.14)

• Ergonomics 

• Guidelines
– Monitor position 

– Adjustable chair

– Proper position while 
typing

– Take breaks

– Adequate lighting

• Assistive (adaptive) 
technologies
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Questions



Copyright © 2018, 2017, 2016 Pearson Education, Inc. All Rights Reserved

Copyright
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of the publisher. Printed in the United States of 
America.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, without the prior written permission of the publisher. Printed in the United States of 
America.

Technology In Action Complete 14th Edition Evans Solutions Manual

Visit TestBankDeal.com to get complete for all chapters

https://testbankdeal.com/download/technology-in-action-complete-14th-edition-evans-solutions-manual/

